Monte Carlo Air Taxi Simulator Program

User’s Guide (v2.5)

Prepared by

Matt Toniolo & Jason Brindel
# Table Of Contents

1 Introduction................................................................................................................. 1
   1.1 Overview............................................................................................................. 1
   1.2 File and Directory Structure................................................................................ 1
      1.2.1 Program Files .............................................................................................. 1
      1.2.2 Project Files ............................................................................................... 2
2 Starting the Program ................................................................................................... 4
   2.1 Working with Projects ........................................................................................ 5
      2.1.1 Create New Project ..................................................................................... 7
      2.1.2 Load Existing Project .................................................................................. 8
      2.1.3 Close Project ............................................................................................... 8
      2.1.4 Save Project As ........................................................................................... 9
      2.1.5 Save Project ................................................................................................ 9
3 Input Parameters ....................................................................................................... 10
   3.1 Simulator Options ............................................................................................. 10
      3.1.1 Air Taxi Simulator Options ...................................................................... 10
   3.2 Airport Selection............................................................................................... 12
      3.2.1 Air Taxi Airport Selection ........................................................................ 12
   3.3 Aircraft Properties............................................................................................. 16
      3.3.1 Air Taxi Aircraft Properties...................................................................... 16
   3.4 Passenger Statistics ........................................................................................... 21
      3.4.1 Air Taxi Passenger Statistics .................................................................... 21
   3.5 Cost Related Issues ........................................................................................... 27
      3.5.1 Air Taxi Cost Parameters .......................................................................... 27
   3.6 Weather Parameters .......................................................................................... 31
      3.6.1 Air Taxi Weather Parameters .................................................................... 31
4 Analysis .................................................................................................................... 34
   4.1 Air Taxi Service Dispatch Logic ...................................................................... 35
      4.1.1 General Approach ..................................................................................... 35
      4.1.2 Aircraft Selection for Passenger Flights ................................................... 37
4.1.3 Deadheading Strategy ................................................................. 38
4.1.4 Delayed Flights ......................................................................... 41
4.1.5 Aircraft Hold Patterns ................................................................. 42
4.1.6 Weather Effects ......................................................................... 42
4.1.7 Pilot Operations ......................................................................... 46
5 Graphic Animation Depiction ............................................................ 48
6 Output Data ....................................................................................... 52
  6.1 Profit Margin/Ticket Price .............................................................. 52
    6.1.1 Air Taxi Profit Margin/Ticket Price ........................................... 52
  6.2 Airport Data .................................................................................. 53
    6.2.1 Air Taxi Airport Data ............................................................... 53
  6.3 Aircraft Data ................................................................................ 54
    6.3.1 Air Taxi Aircraft Data ............................................................. 54
  6.4 Passenger Data ............................................................................ 56
    6.4.1 Air Taxi Passenger Data ........................................................ 56
  6.5 Expenditures/Revenue Data .......................................................... 61
    6.5.1 Air Taxi Expenditures/Revenue Data ....................................... 61
  6.6 Pilot Data ...................................................................................... 66
    6.6.1 Air Taxi Pilot Data ................................................................. 66
Appendix A – Air Taxi Cost Element Definitions .................................. A-1
Appendix B – Air Taxi Input/Output Summary ...................................... B-1
1 Introduction

1.1 Overview

The MCATS program (Monte Carlo Air Taxi Simulator) is a Microsoft Windows \textsuperscript{TM}-based C++ application for analyzing the feasibility and business aspects of small airport transportation services for multiple regions of the US. The current software version models an air taxi service provider, which is explained in Section 4.1. In order to more closely model system uncertainties, MCATS utilizes a Monte Carlo analysis approach to statistically vary parameters throughout the simulation.

The major parts of the program include an inputs section for specifying system parameters, an analysis section for numerically simulating the selected service type, a visualization section for animating portions of the simulation, and an outputs section for tabulating and plotting results. The purpose of this guide is to provide operating instructions and detailed descriptions of these various sections.

1.2 File and Directory Structure

1.2.1 Program Files

The MCATS program itself consists of a main executable file along with several other image and data files placed in various directories. The top level directory is called, “MCATS.” The following list describes the contents of each subdirectory. Note that the directory tree should not be changed or the program may fail to run.

- **bin/** - Contains the main executable file, \texttt{MCATS.exe}, and several shared library files (*.dll), which provide functionality and data for the Qt GUI interface, and MCATS map regions. \textbf{Note that the executable file must reside in the same folder as the .dll in order for the program to operate correctly.}

- **data/Airport Data** - This folder contains an ASCII text file for each map region included with the copy of MCATS. Each file contains a default list of available of airports used in the simulation for a particular map region. This data is used by the
aircraft data input menu. The user may add additional default airports to these files by mimicking the existing field orders within these files.

- **data/** – In addition to the Airport Data folder above, the data folder contains one or more Weather Data subdirectories, each of which contain archived weather data for the year spanning from July 1, 2002 to June 30, 2003. There will be a separate Weather Data folder for each available map region.

- **docs/** - Contains electronic copies of this user’s guide and other relevant material.

- **tempproject/** - This folder is used by MCATS to store temporary output files.

### 1.2.2 Project Files

The MCATS program uses several binary files to store input parameter values and output data for a given business analysis case study. The collection of these files and the directory tree used to arrange them are referred to as project files. Each separate case study will consist of a top level project directory named by the user (e.g., Case1/). The directory tree contains the following items.

**Case1/**
- inputfile.spf
- inputrecord.txt

**Air Taxi/**
- outputdata.sbf
- animationMC1.sbf
- animationMC2.sbf …
- *.csv [various analysis outputs]

- **Case1/inputfile.spf** – This user-named file is used to store all input parameter values. Whenever a project is loaded into the MCATS program, data from this file will populate the input menus.

- **Case1/inputrecord.txt** – This ACSII text file contains a user-readable record of all input parameters, and can be used to launch MCATS batch runs which bypass GUI inputs.

- **Case1/Air Taxi/** - Contains all Air Taxi model output data files.
• **Case1/AirTaxi/outputdata.sbf** – This file contains all analysis data, for all Monte Carlo simulations, used for the output data plots and tables (see Section 6).

• **Case1/AirTaxi/animationMC#.sbf** – These files contain information used by the simulation viewer window to animate the simulation results (see Section 5). Data for each Monte Carlo iteration is stored in a separate file. The “#” symbol in the file name above is actually the Monte Carlo iteration number.

• **Case1/Air Taxi/*.csv** – These files contain all the results from the simulation that are seen in the GUI after an MCATS analysis. These files allow a user to view results outside the MCATS GUI environment. An exception is the “BudgetAnalysisMCATSOutputs.csv” file, which gives useful financial outputs not all shown in the GUI.
2 Starting the Program

To launch the MCATS program, ensure your USB dongle is inserted (light is on) and double click the following executable from the directory structure noted in Section 1.2.1.

- `../MCATS/bin/MCATS.exe`

Figure 2-1 Illustration of the main interface to the MCATS program.

Figure 2-1 illustrates the main interface to the program along with its various components, labeled A–I. The top left portion of the window contains a menu bar, with its constituents labeled as A–F, which is used for accessing project files, input parameters, running analysis, launching the animation, displaying outputs, and displaying program version information respectively. When the program is initially launched, only the “File” pull down menu (label A) will be active. Additional pull down menus will become active at appropriate times. For example, the outputs pull down menu will not
become active until analysis data has been generated. Region G contains a summarized listing of most input parameters, once they have been specified by the user via the various input submenus (discussed in Section 3). The purpose of this listing is to provide convenient (read-only) access to input parameters at all times, and to provide a context for visual simulations and output data. Region H contains and manages all output data windows and the animation window. Region I contains a list of the random number seeds used for each Monte Carlo simulation during the analysis. Each seed value produces a unique and fully repeatable set of results.

### 2.1 Working with Projects

Upon launching the MCATS program, the user must choose to create a new project, or to load an existing project prior to performing any analysis. Both actions are initiated by accessing the “File” pull down menu, or by selecting the corresponding toolbar buttons located directly under the menu bar in Figure 2-1. When creating a new project, the user will be prompted for which region to load as shown in Figure 2-2. Regions which have not been installed will not be selectable, and will be grayed out.
Figure 2-2 Dialog box prompts user to select map region upon creating new MCATS project.
Regions not installed will be grayed out.

When working with any project in MCATS, all generated files will be placed in the tempproject/ folder. This is done so that users can immediately begin working without having to first choose a save file, and so that loaded save files are not altered unintentionally. The user can select a permanent location to store results at any time by clicking **File->Save As**, which will prompt MCATS to copy the contents of the temporary folder to the save folder area. Once a save location has been selected, the full
path of the current save folder will be placed in the lower left corner of the main MCATS window. Pressing File->Save will copy the current contents of the tempproject/ folder to the current save file area. Also, only one project can be open at time in MCATS. In order to start a new project, or to load a different project, any opened project must first be closed by selecting File->Close Project.

Lastly, as mentioned in Section 1.2.2, MCATS uses several files to store simulation data. It is therefore possible to make changes to input parameters without rerunning the simulator to generate corresponding output files. When this occurs, the input data files are inconsistent with the output data files. MCATS will allow projects to be saved in this state, but displays a dialog box warning the user of this issue upon loading and exiting, as shown in Figure 2-3. In order to make the files consistent, rerun the analysis. In addition, each output window displays an icon in the upper left corner indicating whether the data is consistent with the inputs. A green “✓” icon represents consistency, and a red “X” indicates a mismatch.

![Figure 2-3 MCATS dialog box that warns of a mismatch between input and output data save files.](image)

### 2.1.1 Create New Project

To create a new case study project from scratch, choose File->New Project from the pull down menus, or press the “New Project” button on the toolbar. The following actions will occur:

1. The “Input” (label B in Figure 2-1) pull down menu will become enabled, and the user will have access to all input submenus.
2. The input submenus will contain the standard set of default data that is assigned by the program for the active service mode.
3. The “Analysis” (label C in Figure 2-1) pull down menu will also become enabled, so that the user may run the analysis at any time for the active service mode.
4. The “Animation” and “Output” (labels D and E in Figure 2-1) pull down menus will remain disabled, since no analysis data has yet been generated.

2.1.2 Load Existing Project

To load an existing case study project, choose File->Open Project from the pull down menus, or press the “Open Project” button on the toolbar. After selecting an existing project file and path, the following actions will occur:

1. MCATS will automatically load the appropriate map region data that was used to create the save file.
2. The “Input” (label B in Figure 2-1) pull down menu will become enabled, and the user will have access to all input submenus for the active mode.
3. The input submenus will contain data loaded from the project save files.
4. The “Analysis” (label C in Figure 2-1) pull down menu will also become enabled, so that the user may run the analysis at any time.
5. If output data had been generated for that project during a previous session, then the “Animation” and “Output” (labels D and E in Figure 2-1) menus will be enabled. That is, if appropriate output data files exist in the project directory tree, the user can directly view visual simulation and/or output data without rerunning the analysis. If no output data is available from the project save files, then the “Animation” and “Output” menus will remain disabled, until analysis has been run. All output data will be relevant to the active service mode.
6. The lower left portion of the main MCATS window will display the full path of the current project location.

2.1.3 Close Project

MCATS can only support a single opened project at any one time. If a project is currently opened, the File->New Project and File->Open Project menu items will remain disabled until File->Close Project is selected. When a project is closed, all output windows and animations will be closed, and panels G and I in Figure 2-1 will be cleared.
2.1.4 Save Project As

This option can be selected at any time to copy the current contents of the temporary tempproject/ folder to a user-specified area. The bottom left portion of the main MCATS window will display the most recent user-selected save file path. Note that each saved (.spf) file must be placed in a separate directory from other saved (.spf) files or prior MCATS save files in that directory will be erased!

2.1.5 Save Project

Once an existing project has been loaded, or a save file path has been selected for a new project (via File->Save Project As), the File->Save Project menu item will copy the current contents of the temporary tempproject/ folder to this area. In general, File->Save Project will copy the contents of the temporary folder into the folder area displayed in the lower left portion of the main MCATS window. If no path is displayed, the File->Save Project option will behave like File->Save Project As.
3 Input Parameters

Once an existing project has been loaded or a new project has been created, the user is free to interact with the input parameter values for the active service mode. The inputs are divided into six main categories, which include simulator/analysis options, airport information, aircraft information, passenger information, service provider cost information, and weather parameters. The following subsections outline each input category.

3.1 Simulator Options

3.1.1 Air Taxi Simulator Options

Figure 3-1 illustrates the layout of the Simulator Options input menu and all of its input fields. This menu is accessed by selecting Input->Simulator Options… from the menu bar, and is used to collect information including the operational mode, service mode type(s), start date and duration of the simulation, total number of Monte Carlo simulations, initial random number seed, as well as Boolean switch values used to control the flow of the dispatch logic. Listed below is a description of each group of input fields corresponding to labels A–E in Figure 3-1.
A – The Operational Mode section provides two mutually exclusive radio buttons for selecting between “Service Provider Profit Margin,” and “Passenger Cost per Seat Mile.” Although both of these parameters are used during the analysis, only one can be prescribed, while the other yields a result. Place the corresponding numerical value in the text field directly below the chosen radio button. The text field below the unselected radio button will be disabled. Both text fields accept floating point numbers.

B – The Air Taxi dispatch strategy currently contains a single switch for turning deadhead flights on and off. If selected, the dispatch logic will attempt to fly in nearby unused aircrafts to alleviate excess passenger demand. See Section 4.1 for more information.

C – The Time section contains the following fields:

⇒ **Duration of simulation** – This number represents the total time length of each Monte Carlo simulation from the prescribed start time. Enter an integer or floating point value, and select the appropriate units from the selection box.
⇒ **Number of Monte Carlo Simulations** – Represents the total number of Monte Carlo simulations to perform during the analysis. Enter an integer value.

⇒ **Start Date of Simulation** – Select a date to begin the simulation. The simulation will begin at 12:00 AM on that date.

⇒ **Initial Random Number Seed** – At the beginning of each analysis run (i.e., an analysis run encompasses all Monte Carlo simulations), this number is used to reset the random number generator. Enter a positive integer value.

**D** – The comments text box enables users to (optionally) supply comments relating to a particular analysis run. The text is displayed in the descriptor section of each output data window.

**E** – These are general purpose buttons for loading default parameters, canceling changes to the menu, and accepting changes to the menu. **Note that “Default” always implies standard default values, not the values originally loaded from an existing project file.**

### 3.2 Airport Selection

#### 3.2.1 Air Taxi Airport Selection

Figure 3-2 illustrates the layout of the Airport Selection input menu, which is accessed by selecting **Input->Airport Statistics…** from the menu bar, and is used to for selecting the airports that will participate in the simulation (for all Monte Carlo simulations). Listed below is a description of each group of input fields corresponding to labels **A–E.**

**A** – This graphic is used to illustrate which airports have been selected to participate in the simulation. Solid black icons represent selected airports, while empty (white centered) icons represent unselected airports. Icons with an extra ring represent airport locations with local catchment populations that exceed 1,000,000 people. Two exclusive radio buttons are used to toggle between a map that only includes airports that lie within the illustrated states of the active region, and a larger map
which may include additional out-of-state airports (in some regions). Airports can be selected/unselected by mouse clicking directly on the airport icons.

**B** – This is a checklist which, by default, contains all of the pre-selected airports names as well as their residing city names, FAA identifier, state, longitude and latitude coordinates, METAR association, takeoff/landing minima, and local populations. A checkmark placed next to the airport name indicates that the airport is selected. The icons shown/selected in **A** are consistent with the airports listed/checked in this table. The currently selected airport (highlighted with gray background) causes the corresponding icon on the map to blink. The column labeled “METAR Dataset” is used to assign actual weather conditions to the airport. The METAR weather data archive contains data for many of the airports in the default list and is referenced by FAA identifier. In any event, if an airport is not associated with a METAR dataset (i.e., blank space in this column), then it will be assumed that the airport always has acceptable ceiling/visibility conditions in the simulation. Alternatively, if a METAR dataset is not available for a particular airport, the conditions can be approximated by assigning the data from a neighboring airport by using the Edit Airport button in **D**. A minimum takeoff visibility and ceiling, as well as a minimum landing visibility and ceiling field is offered for each airport. This will allow the user to simulate existing precision/non-precision approaches at individual airports in order to better understand implications of weather minima. During the simulation, if the values in the METAR dataset at any airport fall below these minimums, aircraft will not be allowed to takeoff or land. Blanket overrides for all takeoffs and landings are provided for in **C**.

**C** – To better understand implications of technologies which may offer lower landing minima (i.e. the SATS program), a blanket override is provided for both takeoff and landing minima. If selected, entries here will override the settings at all specified airports.
D – New airports can be added to the list, and existing airports can be deleted or edited by accessing these buttons. Both the “Add New Airport” and “Edit Airport” dialog boxes share a similar interface as shown in Figure 3-3. Here all parameters that appear in table B can be edited/set. The catchment population figures are based on the preconfigured airport sets (drawing from surrounding county population data) – if new airports are added, the user may need to adjust the existing populations of nearby airports. Specifying the time zone allows MCATS to take the local time into account when setting up demand (Figure 3-7). When setting the values of west longitude and north latitude, only use positive numerical values. The METAR dataset selection box provides a way to set or change an airport’s associated weather data. The default associated METAR data identifier is the airport’s own FAA identifier, if the data set exists in the archive. Otherwise, the field displays “-none-.” Lastly, the default button in D restores the table to its default list.

E – This option allows the user to set every airport in the menu B, whether checked or not, as an alternate landing facility (in the event of en-route weather diversions and pre-flight planning). By default this is option is selected; If turned off, aircraft are forced to land only at those airport facilities that are highlighted for use in the simulation.
When airport configurations are changed, previous demand associations are lost, as the program will project demand based on the *new* airport pairings. To ensure data that has been entered previously is not accidentally overwritten, dialog boxes like the one in Figure 3-4 are presented prior to changing origin-destination demand data or aircraft distributions.
3.3 Aircraft Properties

3.3.1 Air Taxi Aircraft Properties

Figure 3-5 and Figure 3-6 illustrate the layout of the Aircraft Statistics input menu, which is accessed by selecting Input->Air Taxi Aircraft Properties… from the menu bar. This menu is broken into three major parts, which are presented on separate tab sheets. Tab sheet 1 is used to gather aircraft specific properties such as fuel usage and number of seats. Tab sheet 2 is used for assembling aircraft fleets for each selected service type. Tab sheet 3 is used to initially distribute the aircraft fleet to various airports. In addition, this menu is dependent upon information from the Simulation Options menu, and the Airport Selection menus. Listed below is a description of each group of input fields corresponding to labels A–H in Figure 3-5 and Figure 3-6.

A – Used for organization to select between the “Aircraft Properties” tab, the “Fleet Distribution” tab, and the “Initial Distribution to Airports” tab.
Figure 3-5: Tabs 1 and 2 (of 3) of the Aircraft Statistics input menu.
Figure 3-6: Tab 3 of the Aircraft Statistics input menu.

**B** – This table contains a list of aircraft specific properties. The current software version includes six default aircraft types listed across the column headings. The rows contain the properties for each of the six aircraft types. All properties, including the aircraft name, are editable. The “Air Taxi Candidate” option allows for easier sorting in the “Fleet Distribution” tab. An (editable) “yes” or “no” indicates whether a given aircraft type can be used for that service type. The “fuel type” entry allows corresponding inputs from the cost menu to be applied. The “pressurized” entry relates to weather avoidances (in the weather input menu). The “maintenance failure likelihood” field appears when the box in **C** is checked. When that box is selected, the user is able to set the probability of unscheduled maintenance event for each aircraft type. The duration of this event is determined by other entries in **C**.

**C** – The checkbox allows the user to either simulate or disregard random maintenance failures within the fleet. Shortly before a dispatch, a random event may be triggered when this is selected. The user may specify (in hours or days) a distributed duration for these unscheduled events, during which the aircraft is out of service, and others in the fleet are required to fill-in for the unavailable craft. When an aircraft goes out...
of service, passengers depending on that craft for transportation will be taken by another aircraft (if available), or denied (if not available).

**D** – This table is used to assemble a fleet of aircraft based on the total number of aircraft (label **E**) distributed among the allowable aircraft types. As in Table **B**, the columns represent the six available aircraft types. The seventh column contains the total number of aircraft designated for each row’s service type. By default, the fleet is composed of nearly\(^1\) equal numbers of each available aircraft type. This can be changed by manually adjusting the column values in a given row. If the fleet size equals the total number of aircrafts, the seventh column value appears green, otherwise it appears red to indicate a counting error. Lastly, a black (read-only) box appears in cells where aircrafts of that column’s type cannot be assigned to the fleet of that row’s service type. For example, Table **B** indicates that Adam A-700 aircraft cannot be used for air taxi service. Consequently, a (non-editable) black box appears in the cell of Table **D** corresponding to Air Taxi/ Adam A-700.

**E** – This field contains the total number of aircrafts (integer) to use for each service type (i.e., each row in Table **D** must sum to this number). The Default button resets the total number of aircraft to 60, and redistributes Table **D** to its default distribution. The value for field **E** must be equal to the total in table **D**; this is not done automatically so that the initial distribution table (**G**) shown in Figure 3-6 is not overridden (so that fleet customizations the user has previously made are not lost).

**F** – The “Evenly Distribute” button forces each row in Table **D** to sum to the total number of aircraft in field **E**. Furthermore, the values are distributed as evenly as possible among the allowable aircraft types.

**G** – This table specifies how the aircraft fleet is initially distributed among the airports selected from the Airport Selection menu. The default distribution is proportional to

\(^1\) The number of aircraft from each aircraft type is exactly equal if the number of available aircraft types is evenly divisible by the total fleet size for that service type.
the population of the participating airports. The fourth column, “Number of Aircraft,” can be edited to redistribute the aircraft among the participating airports. These (integer) values may be changed so long as the fourth column sums to the total number of aircraft (see label H). The first three columns are read-only.

H – The “Distribution Modifications” section contains a text label that reads, “Total Aircraft,” a balance button, and a default button. These widgets are used for balancing the integer distribution in Table G.

⇒ “Total Aircraft” text label – This label indicates the current total aircraft sum in the Table (i.e., the sum of column four). The text label appears green if the sum is equal to the total number of aircraft (from E), and appears red otherwise.

⇒ Balance Button - If, after modifying Table G, the values do not sum to the total number of aircraft, select one or more cells in the fourth column (hold down the CTRL key to select multiple cells). Press the balance button to redistribute the surplus/deficit of aircraft among the selected cells. This distribution is proportional to the population of the airport community. If the selected cells could not completely balance the surplus/deficit, select additional cell(s) and repeat the process.

⇒ Default Button – Press this button to replace the contents of column four with default values, which are based on the city populations of the chosen airports.

I – The “Override default turn-around time between landing and takeoff” box can be checked in order to change the “busy” time for aircraft (simulating passenger egress; aircraft refueling; and loading luggage, cargo, and/or passengers). The default time in MCATS for these actions is 15 minutes. This switch allows the user to override and increase/decrease that time.

J – When checked, the “Return Aircraft/Pilots to their Home airports at the end of each day” option will attempt to return all aircraft to the home base of their crew. When air taxi operations have completed for the day, those aircraft not already returned due to the aircraft prioritization scheme (section 4.1.2), will depart for their originating airport whenever possible. Those who cannot (due to weather, maintenance failures, etc.) will continue to attempt the return until 2am. If the
aircraft has not departed by 2am, the crew will charge a per-diem and remain at that airport overnight – then continue normal operations the next day. If this occurs at the normal end-of-week crew swap, the per-diem will still be charged, but the aircraft will be forced to its home as soon as the cause for delay has been remedied.

3.4 Passenger Statistics

3.4.1 Air Taxi Passenger Statistics

Figure 3-7 illustrates the layout of the Passenger Statistics input menu, which is accessed by selecting Input->Passenger Statistics… from the menu bar. This menu is used for collecting passenger-specific information such as each day’s hourly demand schedule (passenger volume), the number of new passenger trips requested each day, and the distribution of passenger departures among the participating airports. The following list provides a description of each input field relating to labels A–J in Figure 3-7.

A – Used for organization to select between the “Passenger Volume,” and “Origin/Destination Statistics” tab sheets.

B – This table is used to define passenger demand over the course of any given day, for all airports. Each of the twenty-four rows provides a probability percentage for an hour interval of time. This information is used to assign random departure times to passengers. By default, the table places peak demand between 8:00-9:00 AM and 5:00-6:00 PM each day. This distribution can be changed so long as column three sums to 100%. The first two columns are read-only. In addition, demand cannot be assigned from 12:00 AM – 4:00 AM to simulate a nightly shutdown period.
**Figure 3-7** Tab 1 and 2 of the Passenger Statistics input menu.

**C** – The “Distribution Modifications” section is used to balance the probability distribution in Table **B** such that column three sums to 100%. The balance button and “Total Percentage:” text label perform a similar function here as they do in the Aircraft Statistics menu on tab 3 (see item **H** in Section 3.3 for details), except that
floating point percentages are used in this case instead of integers. The “Total Percentage” label is green if the table values sum to 100% ± 0.001%. The default button loads the standard default demand profile into the table, which places peak demand between 8:00-9:00 AM and 5:00-6:00 PM each day.

D – This (read-only) chart is used for convenience to graphically display the passenger volume demand from Table B. The abscissa measures 0-24 hours, and the ordinate measures the probability percentage.

E – The Passenger Scheduling section contains several different input fields organized by row. Each row contains three input fields and a default button, which are used to define the random distribution type (normal, uniform, or constant) of the associated parameter, set the range, and to reset the parameter to its default. Unless otherwise stated, MCATS casts a specific random value for each of these parameters once per simulation day, based on the user-specified distribution type and range. The input fields operate as follows:

⇒ The first field contains the 3 distribution types considered (Normal, Uniform, and Constant).

⇒ The second and third field contain either the mean and standard deviation (for Normal), or the upper and lower bound (for Uniform). If Constant is chosen, the value is placed in the second field, and the third field is disabled. All input field titles are interactively updated to reflect the distribution choice.

⇒ The default button restores the row to its original value set.

The input parameters from this section include:

⇒ **Number of Daily New Passenger Trips** – This parameter specifies the total number of new passengers to generate each day in the simulation. The default is a normal distribution with 300 passenger per day with a sigma of 50. This parameter is recast at the beginning of each simulation day.

⇒ **Percent of Same Day Trippers** - This parameter specifies the percentage of passengers that will depart and return on the same day. If a passenger is not a same-day tripper, then she is an overnighter and will return the following day.
The default value is a uniform distribution ranging from 0–100%. This parameter is recast at the beginning of each simulation day.

⇒ **Accommodation Time Interval** – The air taxi service model divides each day into discrete time periods, called accommodation time intervals. All passengers are distributed among these intervals based on their scheduled departure times. The default is a constant value of 2 hours. This parameter is a fixed variable locked to a constant value for the entire simulation.

⇒ **Advanced Reservation Time Interval** – New passengers are given priority based on their reservation time. The earlier the reservation, the higher the priority. Passengers that make advanced reservations are given the highest priority among newly departing passengers. The default is a constant value of 24 hours. This parameter is fixed variable locked to a constant value for the entire simulation.

⇒ **Advanced Reservation Percentage** – This parameter specifies the percentage of passengers that make advanced reservations each day. The default value is a uniform distribution ranging from 0–100%. This parameter is recast at the beginning of each simulation day.

⇒ **Intervals to Requeue Stranded Passengers** – If a passenger is not served during the “Accommodation Time Interval” specified, this option allows the user to simulate passengers willing to wait up to “x” additional intervals for service before they are treated as not served. If at any time during the passenger’s wait, there are available aircraft, but inclement weather prevents service – the service failure is counted as weather related (cancelled trip). This additional requeue opportunity will not span days, and those passengers requesting same-day trips will have return trips denied if they cannot return by midnight.

**F, G, H, I, J** – All five of these sections, which make up tab sheet 2, are closely related. Table **F** contains a (read-only) hierarchical list of origin airports (black text) and corresponding destination airports (blue, cyan and magenta indented text) from each origin. The top level list of origin airports, and each secondary list of destination airports specify a probability distribution, which is used to assign origin/destination pairs to randomly generated passengers. Because table **F** contains multiple
distributions that have separate totals, Table H is provided for viewing and modifying individual passenger distributions. The origin airport distribution or any one of the destination airport distributions can be copied over to Table H by pressing the “Adjust Origins” or “Adjust Destinations” buttons, respectively, near label G. The distribution percentage values in Table H can be modified directly. Once values have been modified, buttons near label I can be used to balance Table H percentage totals, reject changes and clear the table, reload default values, or accept changes and place the updated contents back into Table F. The fields near label J are used to set the maximum passenger comfort time to be in the air, and the minimum and maximum threshold distances between any mutual origin/destination pair to prevent passenger flights between those airports.

Label F - Click on the “+” symbol beside any origin airport listing to expand its corresponding destination airport sub-listing.

Label G – The “Adjust Origins” button will copy the top level (black text) airport listing from Table F to Table H. In order to select a destination airport sub-group:

⇒ Expand the desired destination listing in Table F.
⇒ Select (with the mouse) any blue airport listing within that group. This will enable the “Adjust Destinations” button.
⇒ Press the “Adjust Destinations” button to copy that destination airport listing to Table H.

Label H – Columns one and two are read-only. Column three can be modified to redistribute the passenger probability percentages.

Label I – The “Total Percentages” text label and balance button are used to balance surplus/deficit percentage points in Table H, and function the same as in the Aircraft Statistics menu (see Label H in Section 3.3).

⇒ Empty List Button – This button clears the contents from Table H. Any changes are discarded.
⇒ **Default List Button** – This button resets the probability distribution in column three of Table H. If Table H contains the origin airport listing, then the default values will be based on the local population surrounding each origin airport as defined in the Airport Selection menu. If Table H contains a destination airport listing, then the default values will be based on the current origin distribution in table F.

⇒ **Accept** – This button replaces the appropriate distribution listing in Table F with the contents of Table H.

**Label J** – This section contains 3 parameters which are used to prevent passenger trips between airports that are either too close or too far apart.

⇒ **Maximum Flight Duration for Passenger Comfort** – Defines the maximum amount of time that a passenger flight should be in the air. This does not account for potential hold patterns or diversions to alternate airports. Defaults to 3 hours.

⇒ **Minimum Airport Distance** – A minimum flight service segment may be set. This means that any airports that are less than this distance apart have no passenger demand between these airports. The corresponding destination airport group under any given origin airport in table F, will represent destination airports that are too close by coloring the row magenta (which matches the text color in the minimum airport distance field). The corresponding rows will also show up as magenta in Table H. Magenta colored rows will have 0% passenger demand probability and will not be editable.

⇒ **Passenger Comfort Distance** – This field defaults to and has an upper bound limit that is equal to the maximum distance that the fastest aircraft in the fleet can fly in the specified passenger comfort time, accounting for 10 minutes of flying at half cruise speed to simulate landing and takeoff. Airports that are farther than this value from their corresponding origin will appear cyan in tables F and H, which matches the text color in the passenger comfort distance input field. Cyan colored rows will have 0% passenger demand probability and will not be editable.
⇒ Update Tables Button – This button will update tables F and H when new values have been entered for any of the fields near label J. The button will only be active when changes have been made. As soon as the button is pressed, it will become disabled.

3.5 Cost Related Issues

3.5.1 Air Taxi Cost Parameters

Figure 3- thru Figure 3-11 illustrate the layout of the Cost Related Statistics input menu, which is accessed by selecting Input->Costing … from the menu bar. This menu contains input fields for various types of costs associated with the transportation system that are divided into several groups. Tab sheet 1 considers general service provider costs and taxes, tab sheet 2 considers costs associated with pilots, tab sheet 3 deals with insurance related costs, and tab sheet 4 deals with inventory related costs. All parameters grouped by labels B, C, D, E, H, and I use the generalized (three input field) row structure, which captures random distribution type and range for each parameter, as described in item E of Section 3.4. In addition, unless stated otherwise, all randomized parameters are cast once per Monte Carlo iteration.

A – Used for organization to select between the “Operational Costs,” “Pilot Related Costs,” and “Inventory” tab sheets.
B – The cost parameters in the General category include Administrative and scheduling costs, JetA and 100LL fuel costs, service costs, aircraft depreciation costs, hanger fees, and promotions and advertising costs. Ground transportation costs are associated with having to transport passengers to their intended destination in the event of a diverted flight to an alternate destination due to unfavorable weather conditions. All parameter units are indicated on the menu. The default values are shown in Figure 3-8.

C – The cost parameters in the Taxes category include property tax and income tax. Parameter units are indicated on the menu. The default values are shown in Figure 3-8.

D – The cost parameters in the (pilot) Compensation category include pilot salary and benefits. The salary may also be broken down into pilot and co-pilot pay categories. A further option allows the user to prescribe a setting for minimal paid flight hours per month to guarantee a minimum salary. Per-diem costs for
overnight stays away from home can also be specified. Parameter units are indicated on the menu. The default values are shown in Figure 3-9.

Figure 3-9 Pilot Related Costs tab of the Costing input menu.

E – The cost parameters in the (pilot) Training category include expenditures for professional pilots and for non-professional pilots (non-professional pilots are not currently used). Parameter units are indicated on the menu. The default values are shown in Figure 3-99.

F – This section, shown in Figure 3-10, provides a table for calculating annual aircraft property insurance based on the aircraft’s hull value. The first two columns contain the mean and standard deviation costs associated with professional pilots. The second two columns contain the mean and standard deviation costs associated with non-professional pilots (not currently used). Each row represents a different hull value. The software uses linear interpolation for hull values that fall between table breakpoints. Specific table values are cast once per Monte Carlo iteration based on the user-provided mean and sigma values. The default button restores the table to all default values.
G – This section provides inputs for the annual liability insurance costs. The user has the flexibility to set liability insurance coverage based on the number of passenger seats in the fleet.

Figure 3-11 Inventory cost tab of the Costing input menu.

Figure 3-10 Insurance cost tab of the Costing input menu
**H** – This section, shown in Figure 3-11 contains inventory related cost parameters. The “Hull Value Increase” parameter is used to randomly increase (only) the hull values listed in table **B** of Figure 3-58. In addition, this section contains parameters for non-aircraft costs, and borrowing costs associated with financing the aircraft fleet. A 90% financed fleet is assumed.

**I** – The table in this section provides scheduled maintenance costs (per flight hour) for each aircraft type. These parameters are restricted to a normal distribution, with a standard deviation specified in the table, with an Outer Loop sampling rate. The cost If unscheduled maintenance is selected in the aircraft input menu, costs from the unscheduled maintenance fields will be used. Default buttons restore default values to the table and individual aircraft costs field.

### 3.6 Weather Parameters

#### 3.6.1 Air Taxi Weather Parameters

Figure 3-12 illustrates the Weather Parameters input menu, which is accessed by selecting **Input->Weather Parameters…** from the menu bar. This menu is divided into three tabs for general weather parameters, METAR data specific parameters, and RCM data specific parameters. The METAR data set provides ceiling and visibility conditions on an individual airport basis as a function of time. The RCM data set provides precipitation intensity values for an array of cells located at specific longitude and latitude coordinates. Listed below is a description of each group of input fields corresponding to labels **A - H** in Figure 3-12.

**A** – Used for organization to select between the “General”, “METAR (Airport Conditions)”, and “RCM (Radar)” tab sheets.

**B** – This section controls which, if any, weather effects will be active during the simulation.
C – This section contains input fields relating to aircraft that are delayed due to unfavorable weather conditions. The user can specify the number of minutes to elapse before attempting to dispatch a delayed aircraft, and the total number of minutes to delay an aircraft before canceling the flight.

D – This field allows the user to specify a maximum number of minutes to hold an aircraft in the event that the destination airport’s visibility/ceiling conditions become unfavorable upon approach.

Figure 3-12 Tabs 1, 2 and 3 of the Weather Parameters input menu.
E – These input fields allow users to specify the percentage of time that favorable METAR conditions will be forecasted correctly, and the percentage of time that unfavorable conditions will be forecasted correctly. The two cases are treated separately since the former is typically more accurate than the later due to additional uncertainties when conditions are unfavorable.

F – During the analysis, MCATS attempts to form aircraft trajectories which avoid certain RCM precipitation intensity levels. During the trajectory building process (see Section 4.1.6.1), this parameter is used to bound the overall length of the trajectory to within a factor of the nominal distance between the airports. This helps to keep trajectories from getting too long.

G – These parameters control the weather cell radius of clearance surrounding each aircraft while flying. Pressurized and non-pressurized aircraft can have separate clearance values.

H – This section allows the user to select the minimum weather cell precipitation intensity to be avoided. An aircraft’s trajectory must be clear of weather cells of this intensity or greater within the avoidance distance, set in G.
4 Analysis

Once all of the input parameters have been selected, the business case analysis can be run by selecting **Analysis->Run** from the menu bar on the main window. A progress bar will be displayed during each analysis run so that the user can estimate the amount of time remaining in the simulation. An “Abort” button is available to halt the simulation; if the abort button is pressed, a confirmation popup box will be displayed to ensure the user wishes to stop the analysis.

The MCATS program performs a Monte Carlo analysis by varying the system parameters throughout the simulation. This process operates on two levels referred to as the outer loop, and the inner loop. All parameters are correspondingly classified as either fixed, outer loop, or inner loop variables. The outer loop drives the entire simulation by iterating over the individual Monte Carlo simulations, or samples. Parameters classified as outer loop are recast at the beginning of each of these iterations. The inner loop operates within Monte Carlo simulations, incrementing the analysis by one minute intervals. Inner loop parameters are recast at specified intervals within each Monte Carlo simulation. For example, random passenger lists are generated at the beginning of each day. Fixed parameters are cast once at the beginning of the simulation.

The MCATS analysis routine is comprised of several modules\(^2\) which include a top level simulator module, a service provider module, airport modules, aircraft modules, and passenger modules. Although interdependency exists between modules, each has a separate set of responsibilities and duties.

The simulator module drives the outer loop, and manages the entire simulation process. The service provider module generates passenger lists, handles certain aspects of the dispatch logic, initializes airport and aircraft modules, and provides services to those modules. The Airport modules perform most of the dispatch logic by assembling groups of passengers, assigning aircraft to those groups, and managing all aircraft that enter and

\(^2\) This architecture is implemented as a set of C++ classes. Each module is an instance of its associated class.
leave the airport, as well as maintaining a record of all airport related statistics. The Aircraft modules are responsible for tracking their individual positions, as well as recording all aircraft related statistics such as fuel usage and total distance traveled. Passenger modules record passenger related statistics as they progress through the simulation.

4.1 Air Taxi Service Dispatch Logic

4.1.1 General Approach

The air taxi service model divides each day into discrete time periods, called accommodation time intervals. All passengers are distributed among these intervals based on their scheduled departure times. For example, a passenger with a desired departure time of 8:45 AM will be accommodated at 9:00 AM for a one hour accommodation interval, but not until 10:00 AM for a two hour accommodation interval. Accommodation intervals are based on a midnight reference point. The air taxi service operates by accommodating the highest priority passengers first. Passenger priority (from highest to lowest) is defined by the criteria listed below.

- **Returning** passengers receive the highest priority. They are prioritized amongst themselves by their original reservation time.
- **Departing** passengers receive the lowest priority. These passengers are prioritized amongst themselves by reservation time. Those passengers with advanced reservations will have the highest priority among new passengers.

The accommodation time intervals provide a way to economically accommodate walk-up passengers (by providing time for aircraft to fill before dispatching them), as well as to plan ahead for known reservations (by redistributing fleet to accommodate anticipated stranded passengers). As the accommodation time interval is reduced, the dispatch strategy approaches a purely “on demand” strategy.

During the minute by minute progression of the simulation, all major decisions are made at specific times which include the beginning of each day, at the beginning of each accommodation time interval, within each accommodation time interval, and at the end of
each accommodation interval. The following flowchart outlines the decision process for each region.

![Air Taxi dispatch logic for a given Monte Carlo Simulation. Ti represents accommodation time interval i of given day.](image)

Figure 4-1  Air Taxi dispatch logic for a given Monte Carlo Simulation. Ti represents accommodation time interval i of given day.
4.1.2 Aircraft Selection for Passenger Flights

At the end of each accommodation time interval, all passengers in the queue are assembled into groups based on priority. The best candidate aircraft (if one exists) is then assigned to each passenger group based on the following logic. An attempt is then made to dispatch all aircraft that have been boarded with passengers. Either unfavorable weather conditions or an aircraft noted as “busy” (a nominal time after landing which is mandated prescribed for unloading/loading passengers and fueling the aircraft) may cause certain flights to be delayed.

1. At each airport, assemble a list of all aircraft that are currently on the ground and able to fly (i.e. excluding those which are out of service with maintenance issues).

2. In addition, assemble the list of queued passengers that are scheduled to depart within this accommodation time interval at each airport. With these lists, form groups of passengers who are departing to the same destination. This is done by assigning the highest priority passenger to the head of a group, which means that the head passenger’s destination becomes the group’s destination. Then proceed through the list of remaining passengers, in order of highest priority, to search for other passengers heading to the same destination. These passengers are also added to the group. Once the group is formed, another group is started with next available highest priority passenger in the list. This process is continues until all passengers have been assigned to a group at each airport. Note that it is possible to have single passenger groups.

3. At each airport, the following procedure is followed in an attempt to assign an aircraft from the list in item 1 to each passenger group in item 2.
   a. For each passenger group, in order of highest to lowest priority of the head passenger, choose a best candidate aircraft to accommodate the group.
   b. In order for an aircraft to be considered as a candidate for a particular passenger group, the aircraft must satisfy the following conditions:
      i. If the aircraft is not capable of flying the nominal distance from the origin to destination airport (desired destination of current passenger group’s head passenger) within time and distance constraints, rule out the aircraft as a potential candidate.
      ii. If the pilot crew on the aircraft cannot fly the nominal flight time within daily/quarterly flight time limits, then rule out the aircraft as a potential candidate.
   c. After completing this process, rank the remaining aircraft that do satisfy conditions i–ii above based on the following criteria to determine the best candidate. If none of the available aircraft qualify as a candidate for the current passenger group, then the group is added to the list of stranded passengers, and is removed from the pool of waiting passenger groups. The process is then repeated with the next highest priority passenger group from
item 3a above. Otherwise, the sub-list of candidate aircraft are sorted as follows:

i. When comparing the number of excess seats (could be negative if group size outnumbers seat capacity) remaining after placing the current group on the aircraft, prefer aircraft whose absolute value of excess seats is smaller. If both aircraft have the same number, proceed to ii.

ii. This criterion is used to prefer pilot crews who have more available flight time left for the day. If the accumulated daily flight hours for crews on aircraft A and B are either within an hour of each other, or are both > six hours, proceed to iii. Otherwise, prefer aircraft whose pilot crew has most passenger flight hours left for the day.

iii. If the head passenger’s destination is the home airport of Aircraft A, and is not the home airport of aircraft B, prefer aircraft A. If the opposite is true, then prefer aircraft B. Otherwise, proceed to iv.

iv. If the current (origin) airport is aircraft A’s home airport, and it is not aircraft B’s home airport, then select aircraft B. If the opposite is true, then prefer aircraft A. Otherwise, proceed to v.

v. Prefer aircraft with better fuel efficiency.

d. Once the list of aircraft has been sorted, assign the top candidate aircraft to the passenger group.

e. Proceed to the next highest priority passenger group, and repeat the process with the remaining aircraft list. The process is continued until there are no more available aircraft, or until an attempt has been made to pair all passenger groups with an aircraft.

f. When finished pairing aircraft with passenger groups, record information on all stranded passengers remaining.

g. Attempt to dispatch all aircraft that have passenger groups assigned to them at each airport.

4.1.3 Deadheading Strategy

If deadheading has been enabled in the Simulator Options input menu, Section 3.1, then the following logic is executed at the beginning of each accommodation time interval. The idea is to approximate the number of excess aircraft or number of stranded passengers at each airport based on the current available aircraft, the estimated available aircraft at the end of the accommodation interval, and the currently known passengers in the queue. Last minute walk-up passengers and delayed or diverted incoming aircraft can alter the outcome of this estimate.
1. At each airport, assemble a list of all aircraft that are currently on the ground and ready to fly as well as incoming aircraft that are expected to arrive and be ready to fly before the end of the current accommodation time interval.

2. In addition, assemble a list of currently queued passengers that are scheduled to depart within this accommodation time interval at each airport. With these lists, form groups of passengers who are departing to the same destination. This is done by assigning the highest priority passenger to the head of a group, which means that the head passenger’s destination becomes the group’s destination. Then proceed through the list of remaining passengers, in order of highest priority, to search for other passengers heading to the same destination. These passengers are also added to the group. Once the group is formed, another group is started with next available highest priority passenger in the list. This process is continues until all passengers have been assigned to a group at each airport. Note that it is possible to have single passenger groups.

3. At each airport, the following procedure is followed in an attempt to assign an aircraft from the list in item 1 to each passenger group in item 2. There will typically be either expected excess aircraft left over, or expected stranded passenger groups at each airport.

   a. For each passenger group, in order of highest to lowest priority of the head passenger, choose a best candidate aircraft to accommodate the group.

   b. In order for an aircraft to be considered as a candidate for a particular passenger group, the aircraft must satisfy the following conditions:

      i. If the aircraft is not capable of flying the nominal distance from the origin to destination airport (desired destination of current passenger group’s head passenger) within time and distance constraints, rule out the aircraft as a potential candidate.

      ii. If the pilot crew on the aircraft cannot fly the nominal flight time within daily/quarterly flight time limits, then rule out the aircraft as a potential candidate.

   c. After completing this process, rank the remaining aircraft that do satisfy conditions i–ii above based on the following criteria to determine the best candidate. If none of the available aircraft qualify as a candidate for the current passenger group, then the group is added to the list of stranded passengers, and is removed from the pool of waiting passenger groups. The process is then repeated with the next highest priority passenger group from item 3a above. Otherwise, the sub-list of candidate aircraft are sorted as follows:

      i. When comparing the number of excess seats (could be negative if group size outnumbers seat capacity) remaining after placing the current group on the aircraft, prefer aircraft whose absolute value of excess seats is smaller. If both aircraft have the same number, proceed to ii.
ii. This criterion is used to prefer pilot crews who have more available flight time left for the day. If the accumulated daily flight hours for crews on aircraft A and B are either within an hour of each other, or are both > six hours, proceed to iii. Otherwise, prefer aircraft whose pilot crew has most passenger flight hours left for the day.

iii. If the head passenger’s destination is the home airport of Aircraft A, and is not the home airport of aircraft B, prefer aircraft A. If the opposite is true, then prefer aircraft B. Otherwise, proceed to iv.

iv. If the current (origin) airport is aircraft A’s home airport, and it is not aircraft B’s home airport, then select aircraft B. If the opposite is true, then prefer aircraft A. This reduces pilot per diem expenses. Otherwise, proceed to v.

v. Prefer aircraft with better fuel efficiency.

d. Once the list of aircraft has been sorted, assign the top candidate aircraft to the passenger group, if one exists.

e. If there are too many passengers in the group to fit on the aircraft, then the lowest priority passengers are removed until there are just enough to fill the aircraft. The removed passengers are placed back into the pool of waiting passengers, and the list is resorted into groups using the logic in item 2 above.

f. Proceed with the new highest priority passenger group, and repeat the process with the remaining aircraft list. The process is continued until there are no more available aircraft, or until an attempt has been made to pair all passenger groups with an aircraft.

g. When finished with this estimation, report any anticipated excess aircraft or stranded passenger groups to the service provider module so that the excess aircraft can be deadheaded to accommodate passengers that are expected to be stranded otherwise.

4. The service provider module then takes this information from all airports, and attempts to redistribute excess aircraft to neighboring airports that are expected to have stranded passengers. The decision making process for selecting which aircraft are sent to which airports is governed by the following logic.

a. In order of the highest priority stranded passenger group (regardless of location of group) to the lowest, determine if an aircraft is available that can accommodate the group and choose the best candidate if several choices exist.

b. In order for an aircraft to be considered as a candidate for a particular stranded passenger group, the aircraft must satisfy the following conditions:

i. The aircraft must be able to fly to the stranded group’s location on a full tank of fuel. If the distance is too far, rule out the aircraft as a potential candidate.

ii. The aircraft must be able to reach the stranded group’s location and be on the field before the end of the current accommodation interval. If this is not possible, rule out the aircraft as a potential candidate.
iii. The aircraft must be able to accommodate the passenger group’s travel needs. If the aircraft cannot fly the group from their origin to destination on a full tank of fuel and within passenger comfort time limits, then rule out the aircraft as a potential candidate.

c. After completing this process, rank the remaining aircraft that do satisfy conditions i–iii above based on the following criteria to determine the best candidate. If none of the available aircraft qualify as a candidate for the current stranded passenger group, then the group is not accommodated and passenger denial statistics are recorded. The process is then repeated with the next highest priority passenger group from item 4a above. Otherwise, the sublist of candidate aircraft are sorted as follows:

i. If aircraft A is closer to the passenger group’s location than aircraft B, prefer aircraft A. If the opposite is true, prefer aircraft B. Otherwise, proceed to ii.

ii. This criterion is used to prefer pilot crews who have more available flight time left for the day. If the accumulated daily flight hours for crews on aircraft A and B are either within an hour of each other, or are both > six hours, proceed to iii. Otherwise, prefer aircraft whose pilot crew has most passenger flight hours left for the day.

iii. If the current location of aircraft A is its home airport, and aircraft B is not currently at its home airport, then select aircraft B. If the opposite is true, then prefer aircraft A. Otherwise, proceed to iv.

iv. Prefer aircraft with better fuel efficiency.

d. Once the list of potential candidate aircraft has been sorted, the top candidate for the stranded passenger group in question is selected. The selected aircraft is then dispatched to the group’s location as soon as it is ready to fly.

e. This process is repeated for the stranded passenger group with the next highest priority until all of the available aircraft have been dispatched, or until an attempt has been made to pair an aircraft with the entire list of stranded passenger groups.

### 4.1.4 Delayed Flights

The decision to dispatch a waiting aircraft depends on the weather conditions at both the origin and destination airports, as well as the radar conditions along the way. Section 4.1.6 describes these conditions in more detail. If any of the weather conditions are unfavorable, or if the conditions require a large increase in the trip distance in order to avoid weather, then the flight will be delayed. Based on the settings in the Weather Parameters input menu, Section 3.6, an attempt will be made to dispatch the aircraft again at regular intervals (15 minutes by default). Once the total delay time has elapsed (1 hour
by default) the flight will be cancelled. Information will recorded for all passengers who have cancelled flights.

### 4.1.5 Aircraft Hold Patterns

In MCATS, an aircraft is exactly 15 minutes from the destination airport when it reaches the IAF (Initial Approach Fix) along its trajectory. If the actual weather conditions at the destination airport are unfavorable when the aircraft reaches the IAF point, then aircraft may be instructed to execute a hold pattern. A similar decision must be made when the aircraft reaches the destination airport. The criteria for making these decisions are described in Section 4.1.6.2.

In any case if the weather conditions at an airport change from unfavorable to favorable, any aircraft that are approaching that airport and are executing a holding pattern are instructed to continue flying towards the airport for landing. The conditions are checked at each simulation time step (1 minute) at each airport.

### 4.1.6 Weather Effects

There are two types of weather data used by the MCATS software. The METAR dataset contains ceiling and visibility conditions on an individual airport basis. The RCM dataset contains 10 km x 10 km (radar) precipitation intensity data cells for the region of interest. Both weather datasets contain actual recorded conditions from July 1, 2002 to June 30, 2003; however, the year timestamp is effectively ignored so that MCATS can apply the data to any simulated date.

#### 4.1.6.1 RCM Weather (Radar Data)

The RCM data is used by MCATS to construct aircraft flight trajectories between airports. Figure 4-1 shows a color coded representation of the RCM weather cells superimposed on region of interest, along with a sample trajectory which avoids all weather cells. Users select a threshold cell value (represented as a color) and an
avoidance distance for pressurized and non-pressurized aircraft in the Weather Parameters input menu. Based on these settings, all points along an aircraft’s trajectory must miss weather cells that are ≥ the threshold value by the avoidance distance.

Figure 4-1 Illustration of RCM weather cells superimposed on map region along with a sample aircraft trajectory which avoids all weather cells.

When an aircraft in MCATS is ready to be dispatched, a trajectory must first be constructed which is known ahead of time to miss weather cells above the threshold. As illustrated in Figure 4-1, steps are taken along the proposed trajectory to determine if the area will be clear at the time when the aircraft reaches that point. That is, no forecasting is used for constructing trajectories as it is assumed that the pilot can view and avoid actual weather in real-time. MCATS first attempts to construct the nominal trajectory which consists of a single great circle arc connecting the origin to the destination. If the trajectory or its surrounding radius of clearance region intersects with bad weather cells, then a two leg trajectory is attempted iteratively. During this phase, a proposed two leg trajectory is deviated farther and farther from the nominal path until either the two leg trajectory avoids bad weather cells, or becomes too long. Similarly, if a two leg trajectory cannot dodge the weather cells in a practical manner, MCATS will construct three leg trajectories in a similar manner as a last attempt. If the three leg trajectory becomes too
long before being able to successfully dodge the weather cells, the aircraft is delayed. In addition to the satisfying weather conditions, any acceptable trajectory must also satisfy the aircraft’s flight range limitations and passenger comfort time limits.

4.1.6.2 METAR Weather (Airport Conditions)

The METAR weather data is used to determine whether an aircraft pending dispatch must be delayed or cancelled, and to determine whether airborne aircraft must hold position or divert to an alternate airport. The following list describes these decision processes. Note that parameters that are followed by the text “(default)” refer to input parameters gathered from the Weather Parameters input menu in Section 3.6.

1. Before an aircraft can take-off, several steps must be taken:
   a. Check the ceiling and visibility conditions at the origin airport. If conditions are below user specified minimums delay the aircraft by 15 minute (default) intervals. At the end of each 15 minute interval, check again.
   b. If conditions are OK, attempt to construct a trajectory from the origin airport to the destination airport which (1) does not intersect with bad weather cells, (2) takes <= 3 hours (default) to travel within passenger comfort limits, and (3) has a total distance that is within the aircraft’s range (minus safety factors). Lastly, (4), the nearest airport to the destination will be chosen as the “backup” alternate airport in case an alternate free of weather cannot be located in 2c below. The aircraft must have enough fuel to fly the original path, hold for 30 minutes (default), and fly to the “backup” alternate airport with a reserve of 45 minutes of fuel to spare. If steps (1) – (4) cannot be accomplished, delay flight for 15 (default) minutes and repeat from step 1a.
   c. If conditions are OK at origin airport, and successful trajectory has been created, then forecast (based on random factor) visibility/ceiling conditions at destination airport at time of arrival. If not OK for time of arrival, delay flight for 15 (default) minutes and repeat from step 1a.
   d. If conditions 1a – 1c are OK, dispatch aircraft. It will be assumed that all dispatched aircraft will have a full tank of fuel.
   e. If at any point the aircraft’s cumulative delay time exceeds 1 hour (default), cancel the flight and record cancellation statistics.

2. Once the aircraft has left the origin airport, and is in flight, do the following:
   a. When an aircraft reaches the IAF (Initial Approach Fix) point along its trajectory towards the intended destination airport, a decision must be made whether to 1) proceed with the descent, approach and landing, or 2) divert to
an alternate airport, or 3) to hold at the current position until weather conditions at the destination airport will permit the approach and landing.

i. Get a reading of current visibility/ceiling conditions at the destination airport. If conditions are currently above minimums, continue flying towards airport for landing. If conditions are below minimums, get a time prediction, $\Delta t$, on when conditions will be acceptable.

ii. If conditions are below minimums, and $\Delta t < 30$ minutes (default hold time), hold position at IAF until $t + \Delta t$, then proceed to land (assumption is that 15 minute forecast for good weather is accurate). If the forecast correctly predicts that $\Delta t > 30$ minutes (default hold time) immediately divert to nearest acceptable alternate airport. If the forecast is in error (airport predicted to be above minimums at $t + 30$ minutes), hold at IAF for 30 minutes then divert to nearest acceptable alternate airport.

iii. For the purposes of the simulation, whenever an aircraft executes a hold position at an IAF, it will still be considered to be 15 minutes away from the airport when flight resumes. Effectively, when viewing the animation playback of the simulation, any aircraft holding at an IAF point will appear to stop flying at a distance just short of the destination airport. When the hold position maneuver ends, the aircraft will begin moving again towards the airport. Aircraft diversion to the nearest acceptable alternate airport will also be depicted.

b. For all aircraft approaching their destination airport for landing, an additional decision must be made 1 simulation time step (1 minute) prior to landing.

i. If the current ceiling/visibility conditions are (actually) above minimums, land as scheduled. If the current ceiling/visibility conditions are (actually) below minimums, get a time prediction, $\Delta t$, on when conditions will be acceptable. Note that this should only occur if the METAR data changes during the 15 minute time interval between the IAF and landing.

ii. If conditions are below minimums and $\Delta t > 30$ minutes (default), AND the forecast correctly predicts that conditions will not improve in the next 30 minutes, divert aircraft to nearest alternate airport as described in 2c. Add penalty factor to fuel consumption for having to regain altitude which is implemented as an immediate subtraction of 15 minutes worth of fuel. If the forecast is in error (airport predicted to be above minimums at $t + 30$ minutes), hold for 30 minutes then divert to nearest acceptable alternate airport, incurring the same altitude regain fuel penalty.

iii. If conditions are below minimums, AND $\Delta t \leq 30$ minutes (default hold time), then hold position near the airport. Add penalty factor to fuel consumption for having to regain altitude for holding position which is implemented as an immediate subtraction of 15 minutes
worth of fuel. Land the aircraft when conditions improve after $\Delta t$ minutes (assumption is that $< 30$ minute forecast for good weather is accurate).

c. If aircraft has to be diverted, then an alternate airport will be chosen that satisfies 3 criteria. Starting with the nearest airport, (1) a straight line path connecting current position and the alternate must not intersect with bad weather cells during the trip, (2) alternate airport must have acceptable ceiling/visibility conditions at time of arrival (using truth data, not a forecast), and (3) aircraft must have enough fuel to get to alternate airport. This process is repeated with the next nearest airport until an acceptable trajectory is found. If after searching through all other (N-1) airports, an acceptable alternate cannot be found, then the aircraft will be forced to land at its “backup” alternate regardless of weather conditions. Stats will be recorded for any aircraft that has to land in bad weather conditions. In any event, ground transportation charges will be applied for each passenger group that has been flown to an alternate airport to represent costs for rental cars, hotels, etc., to return the displaced passengers to their intended airports. These penalty cost will be a function of the distance between the intended and alternate destination airports.

### 4.1.7 Pilot Operations

Pilot crews have also been modeled in MCATS in order to estimate the number of pilots necessary to operate the air taxi service. Pilot crews will consist of either one or two pilots and are subjected to the Federal Aviation Regulation Sec. 135.267 for commercial flying. Users can select the crew size for each aircraft type in the fleet via the Aircraft Statistics input menu in Section 3.3.

Each aircraft will have two pilot crews assigned to it, which will alternate full work weeks. The start date of the simulation will mark the first day of the work week for the first shift crew. After 7 days are up, the crew will return to their home airport (if the aircraft is not there already) and switch places with the second shift crew, and so on. When a crew is assigned to a week of duty, the crew will remain “on call” until one hour before the first scheduled flight for the crew’s aircraft. From that point on, up until the last day of the present work week, the crew will be considered on duty. All pilots will receive a specified pay rate for all hours flown and a lower pay rate for hours not flown but still on duty. All pilots will also be paid for a user-specified minimum number of flight hours per month. Also, if pilots are not at or flying to their home airport, which is
defined by the initial airport distribution of the aircraft to which they are assigned, by midnight a per diem cost will be incurred.

Pilot crews of one or two pilots are subject to the following commercial flight constraints under the Federal Aviation Regulation Sec. 135.267 requirements:

1. No more than 500 passenger flight hours in any calendar quarter.
2. No more than 800 passenger flight hours in any two consecutive calendar quarters.
3. No more than 1400 passenger flight hours in any calendar year.
4. No more than 8 passenger flight hours per 24 consecutive hours for a one pilot crew.
5. No more than 10 passenger flight hours per 24 consecutive hours for a two pilot crew.

In order to simulate a steady state operation, MCATS will apply a simplified constraint which satisfies items 1, 2 and 3 simultaneously. Pilots will be restricted to 350 passenger flight hours per calendar quarter. Items 4 and 5 will be applied directly. Additionally, if a pilot crew has exceeded their passenger flight hours for a particular day, the crew will not accept further passenger flights for that day. If a pilot crew has exceeded their passenger flight time limit of 350 hours for the current calendar month, then the pilot crew would return to their home airport to be replaced by a reserve crew. The reserve crew would continue to serve until either one of the scheduled pilot crews could return to duty, or until the reserve pilot exceeds quarterly limits and has to be replaced by another reserve pilot.

In general, reserve pilots will only be substituted as needed. That is, if no scheduled pilot can accept duty due to quarterly passenger flight limits and no other existing reserve pilot is available, a new reserve crew will be brought in. Reserve pilot crews are assigned to the same home airport as the scheduled pilot, or existing reserve pilot, that they are replacing. Reserve pilot crews can only fill in for crews from the same home airport, and that have the same number of pilots per crew. Reserve pilots will, however, be able to fly any aircraft type in the fleet.
5 Graphic Animation Depiction

Once the analysis has been run, the Simulation pull down menu from the menu bar will become active. Select **Simulation->Animation** to access the Simulation Viewer window, shown in Figure 5-1, which provides a 2D animation of the business case analysis. This feature can be used to analyze any portion of the simulation, in real time or fast time. The animation illustrates the interaction between airports, aircraft, and passengers.

The Simulation Viewer window contains a main viewing area (section A), as well as various controls for operating the simulation, and for displaying simulation states. Section C displays the Monte Carlo simulation iteration that is currently being analyzed. This integer can be changed to instantly load the corresponding set of Monte Carlo analysis data. Section B indicates the start and end time/date of each Monte Carlo simulation. Section E contains a progress bar, which measures the elapsed simulation time from start to end, and also displays the corresponding current simulation time/date. Section D provides buttons for starting, stopping, and rewinding the current Monte Carlo simulation, and a slider for controlling the rate of the simulation playback. The Simulation Viewer window also contains a toolbar (section F), which provides facilities for zooming in or out of the main viewing area. The tables in section G provide information about all individual aircraft and passengers in the simulation.

A – Represents the main viewing area.

B – This section contains two widgets for displaying the start time/date and end time/date of the simulation. All Monte Carlo simulations, from the same analysis case, share the same start and end time/dates.

C – This section displays the current Monte Carlo simulation iteration, as well as the total number of iterations generated from the analysis run. The current iteration (integer) can range from 1 to the total number of iterations. Changing this number automatically loads the corresponding Monte Carlo data set.
Figure 5-1 Simulation Viewer window for displaying 2D animations of the business case analysis.

**D** – This section contains three buttons and a slider. From left to right, the buttons pause, rewind, and start the simulation. If the current simulation time reaches the end time, the simulation will automatically stop. The slider controls the rate of the simulation playback. Although the slider is effectively analog, it contains five key positions marked by vertical lines. The 0% slider position is real time (1 sec real time = 1 sec simulation time), the 25% position is (1 sec real time = 1 minute simulation time), the 50% position is (1 sec real time = 1 hour simulation time), the 75% position is (1 sec real time = 6 hours simulation time), and the 100% position is (1 sec real time = 1 day simulation time). If the slider position falls between two key positions, the playback rate is linearly interpolated.
E – This section displays the current simulation time/date, and displays the amount of elapsed time that has occurred between the start time and the current time, via a progress bar. When the current time reaches the end time, the progress bar will display 100%.

F – The Simulation Viewer window contains its own toolbar for providing zoom capabilities. The buttons include (from left to right):

⇒ **Selection** – When this button is pressed, the user can left-click on individual aircraft or airport icons to obtain real time information.

⇒ **Zoom In** – When this button is selected, left click on the main viewing area to zoom in. The mouse position will mark the center of the zoomed image, and each zoom scales the image by a factor of 2.

⇒ **Zoom Out** – Performs the opposite effect of the Zoom In button.

⇒ **Zoom Selection** – When this button is selected, the mouse can be used to drag a rectangular region (by holding in the left mouse button while moving the mouse) onto the main viewing area. The contents of the rectangle will then be rescaled to fit in the viewing area. The aspect ratio of the original image is always preserved to prevent distortion.

⇒ **Zoom Extents** – This button maximizes the entire map image to a size that will fit into the current viewing area screen dimensions.

The Preferences pull down menu on the Simulation Viewer window provides controls to toggle the aircraft type legend (located in the upper left corner of region A), airport city name labels, and to turn on/off out-of-range regions in the RCM dataset which are represented by gray cells. All out-of-range cell regions are treated as clear with no precipitation in the simulation.

G – This docked window (off by default), titled “Simulation Objects Lists”, contains two tables which provide information about all aircraft and passengers in the simulation. The separate tables are accessed by selecting the appropriate tab at the lower left corner. The passenger table provides a list of all passengers that are departing, returning, or both over the course of the current day, and is updated once per day. This table provides the passenger id, origin and destination airports, scheduled
departure and return departure times, actual departure and return departure times, and whether the passenger is a same-day tripper for each passenger. The text appears red for passengers who have been stranded at some point during their trip. The aircraft table provides the real-time status of all aircraft in the simulation. The table provides the aircraft id, aircraft type, flight status, current origin, current destination, departure time and next arrival time. The dock window can be toggled from accessing Animation->Object Lists from the pull-down menus. Currently, this feature is only available for the air taxi model.
6 Output Data

Output data can be displayed after an analysis run has been completed. The current version of the MCATS program contains six categories of output data, which include profit margin/ticket price, airport related data, aircraft related data, passenger related data, costing related data, and pilot data. Each category provides several different types of plots, which are summarized in the following sections. These top level output sections are also output to .csv files, so that the user can view analysis results outside the MCATS GUI.

6.1 Profit Margin/Ticket Price

6.1.1 Air Taxi Profit Margin/Ticket Price

From the input menu in Figure 3-1, users must either specify a service provider profit margin value, or a passenger cost per seat nautical mile value. This section contains a single plot which displays the corresponding result of this selection, and can be accessed by selecting Output->Profit Margin/Passenger Cost from the menu bar on the main window. An example, using 10 Monte Carlo simulations, is shown in Figure 6-1.

This plot shows the resulting passenger cost, for each Monte Carlo simulation, that results in an after tax profit margin of 15%, as indicated by label A. Label B indicates the average passenger cost over all 10 Monte Carlo simulations. The bottom of the plot window (section C) contains a case descriptor section, which displays general simulation information such as the total number of Monte Carlo simulations, the fleet size, the duration of each Monte Carlo simulation, etc. A text label is also provided to display short comments and remarks that were entered in Figure 3-1. The descriptor is displayed on all output data windows.
6.2 Airport Data

6.2.1 Air Taxi Airport Data

This section contains a single table, shown in Figure 6-2, which summarizes the aircraft and passenger events at each airport, for each Monte Carlo simulation. This plot can be accessed by selecting Output->Airports from the menu bar on the main window. For each airport, the table indicates the number of passenger trips requested, number of passenger trips denied, number of aircraft departures, number of aircraft arrivals, percentage of passengers denied, average number of passengers per flight, number of
originating deadheads, percentage of originating deadheads, number or arriving deadheads, percentage of arriving deadheads, number of originating diverted flights, number of delayed flights, number of cancelled flights, number of cancelled passenger trips, number of passenger trips that were requeued, and the number of those requeued passenger trips which were successful. Total values are also provided below the table. In section A the user can select results from individual Monte Carlo iterations via the spinbox input entry. Alternatively, the user can select the “Average Values” radio button to populate the table with average values over all Monte Carlo iterations.

![Figure 6-2 Airport Statistics output data window.](image)

6.3 Aircraft Data

6.3.1 Air Taxi Aircraft Data

The aircraft data category includes seven plots, which use the same basic template as shown in Figure 6-3. In all cases, the horizontal axis represents the Monte Carlo iteration number, and the vertical axis represents the total quantity (for all aircraft) over the entire corresponding Monte Carlo simulation. For example, Figure 6-3 shows the total nautical
miles traveled by all aircraft for each of the ten Monte Carlo simulations run. The total and/or average value is displayed below the plot area on each data output window. Each of these plots can be accessed by selecting **Output->Aircrafts->(Plot Name)** from the menu bar on the main window. The following list describes the contents of each plot.

- **Total distance traveled**
  ⇒ Shows total distance (NM) traveled by all aircraft during the entire time period of each Monte Carlo simulation.

- **Total time traveled**
  ⇒ Shows total flight time (Hours) of all aircraft during the entire time period of each Monte Carlo iteration.

- **Total time idle**
  ⇒ An aircraft is considered idle if it performs no flying of any kind for an entire accommodation time period (i.e., idle time is quantized). This plot shows the total idle time (Hours) of all aircraft for each Monte Carlo iteration.

- **Idle time percentage**
  ⇒ Idle time percentage is idle time divided by total Monte Carlo simulation time.

- **Airborne passengers per trip**
  ⇒ Shows total accommodated passengers per total aircraft trips for each iteration

- **Airborne deadheading percentage**
  ⇒ Shows the total empty flight time divided by the total flight time for all aircraft for each Monte Carlo iteration.

- **Total number of aircraft flights**
  ⇒ Shows total number of aircraft departures during each Monte Carlo iteration.

- **Aircraft load factor**
  ⇒ Gives the load factor computation for each aircraft type as an entire simulation average or by individual Monte Carlo iteration. Defined as the number of people hours flown divided by total number of flight hours divided by the number of passenger seats on the aircraft.
6.4 Passenger Data

6.4.1 Air Taxi Passenger Data

The passenger data category includes four plots. The first three plots follow the basic format of Figure 6-3. An example of the fourth plot is shown in Figure 6-4. Each of these plots can be accessed by selecting Output->Passengers->(Plot Name) from the menu bar on the main window, and are described below.

- Total passenger distance traveled
⇒ Shows the total (revenue) distance (Nautical Miles) traveled by all passengers during each Monte Carlo simulation. Note that flight distances correspond to nominal origin and destination airports. Extra distances due to weather avoidance or diverted trips are not considered.

- Total passenger time traveled
  ⇒ Shows the total time (Hours) traveled by all passengers during each Monte Carlo simulation, including hold times, diverted trips and weather.

- Percentage of requested trips denied per Monte Carlo simulation
  ⇒ Shows the total percentage of passengers who were unaccommodated for each Monte Carlo simulation. The chart uses stacked bars to distinguish between denied passengers (stranded due to aircraft availability), which is further subdivided based on passenger priority, and stranded passengers due to weather cancellations. Red, yellow and green regions include denied passengers, while blue regions include all passengers stranded due to weather cancellations (regardless of priority level).

- Percentage of requested trips denied per airport for all Monte Carlo simulations
  ⇒ As shown in Figure 6-4, this plot shows the percentage of passengers who were unaccommodated at each individual airport. The horizontal axis contains the id numbers of the airport. The corresponding city name is shown above each data bar, which contains the total value for that airport for all Monte Carlo simulations. The chart uses stacked bars to distinguish between denied passengers (stranded due to aircraft availability), which is further subdivided based on passenger priority, and stranded passengers due to weather cancellations. Red, yellow and green regions include denied passengers, while blue regions include all passengers stranded due to weather cancellations (regardless of priority level).

- Daily Same-Day Trips
  ⇒ This plot shows the daily number of randomly generated passengers that are scheduled to depart and return to their origin airport in the same day. The x-axis corresponds to the Monte Carlo iteration number. Above each is a series of blue dots which indicate the number of same-day trippers. There is one blue
Figure 6-4  Plot which shows percentage of un-accommodated passengers at each individual airport

- Trip Time Statistics
This plot, shown in Figure 6-6, uses bars to show the average and maximum passenger flight time. The flight time corresponds to the total time in the air including multi-leg paths due to weather avoidance, diverted trips to alternate airports, and any hold times. The blue bars show the average value over all passenger trips for each Monte Carlo iteration. The gray bars show the corresponding maximum value. Mouse clicking on individual bars shows the origin and destination (and possible alternate destination airports) associated with the maximum trip duration.

![Figure 6-5 Number of same-day passenger trips scheduled per day plot.](image_url)
Trip Distance Statistics

This plot, shown in Figure 6-7, uses bars to show the average and maximum passenger distance flown, where only nominal distances between origin and destination airport are considered. Mouse clicking on individual bars shows the origin and destination pair associated with the maximum nominal trip distance.

Figure 6-6 Plot to show the average and maximum passenger trip time durations for each Monte Carlo iteration.
Figure 6-7 Plot to show the average and maximum passenger nominal trip distance for each Monte Carlo iteration.

### 6.5 Expenditures/Revenue Data

#### 6.5.1 Air Taxi Expenditures/Revenue Data

This section contains three plots, which can be accessed by selecting **Output->Expenditures/Revenue->(Plot Name)** from the menu bar on the main window. Each of these plots is described below.

- Weekly Cash Flow Statistics
An example plot is shown in Figure 6-8, which consists of 10 Monte Carlo samples of a 3 week simulation. This plot illustrates the after tax profit for each week in the simulation for each Monte Carlo simulation. The data is then rearranged into ascending order based on the Monte Carlo simulation’s average weekly profit. The horizontal axis contains integer index numbers. The vertical axis represents the weekly after tax profit (note that there are 3 data points, one for each week, for each Monte Carlo sample in Figure 6-8). The red numbers next to the blue data points indicate the corresponding Monte Carlo iteration number. The green curve is a spline fit which connects the average weekly profit value for each Monte Carlo simulation. This plot only displays data points for completed weeks (e.g., a 2.5 week simulation would only contain 2 data points per Monte Carlo iteration number).

- **Cost Element Statistics**

  This plot, shown in Figure 6-9, displays the total cost of each expenditure listed in Figure 3- and Figure 3-9 for each Monte Carlo simulation. The horizontal axis represents Monte Carlo iteration numbers. The vertical axis represents the total cost for an entire Monte Carlo simulation. The combo box in section A is used to choose among the various expenditures. The combo box in section B is used to toggle between absolute cost and cost per operating hour per aircraft.

- **Cost Element Distribution**

  This table, shown in Figure 6-10, conveys the impact of each expenditure item listed. The expenditures are placed into descending order with the most expensive at the top of the list. The table provides both the percentage contribution and the dollar amount for each expenditure. Each list corresponds to the total costs accumulated during a single Monte Carlo simulation. Section A can be used to select values for individual Monte Carlo iterations, or to view average values calculated over all Monte Carlo iterations.
Figure 6-8  This plot displays the after tax weekly profit for each Monte Carlo iteration, arranged in ascending order.
Figure 6-9  This plot shows the cost of each individual expenditure item for each Monte Carlo iteration.
Table showing cost element distribution:

<table>
<thead>
<tr>
<th>Cost Element Distribution</th>
<th>Percentage</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aircraft Depreciation Costs</td>
<td>20.926%</td>
<td>$30,811.32</td>
</tr>
<tr>
<td>Fuel Costs</td>
<td>13.757%</td>
<td>$20,255.78</td>
</tr>
<tr>
<td>Borrowing Costs</td>
<td>12.719%</td>
<td>$18,727.49</td>
</tr>
<tr>
<td>Pilot Salary Costs</td>
<td>10.303%</td>
<td>$15,170.23</td>
</tr>
<tr>
<td>Aircraft Maintenance Costs</td>
<td>8.779%</td>
<td>$12,925.58</td>
</tr>
<tr>
<td>Scheduled Maintenance</td>
<td></td>
<td>$12,360.38</td>
</tr>
<tr>
<td>Unscheduled Maintenance</td>
<td></td>
<td>$565.30</td>
</tr>
<tr>
<td>Income Tax</td>
<td>5.002%</td>
<td>$7,364.88</td>
</tr>
<tr>
<td>Promotions and Advertising Costs</td>
<td>4.99%</td>
<td>$7,346.66</td>
</tr>
<tr>
<td>Liability Insurance Costs</td>
<td>4.702%</td>
<td>$6,923.08</td>
</tr>
<tr>
<td>Administrative and Scheduling Costs</td>
<td>4.504%</td>
<td>$6,631.50</td>
</tr>
<tr>
<td>Non-Aircraft Costs (equipment, office supplies, etc.)</td>
<td>4.3%</td>
<td>$6,330.81</td>
</tr>
<tr>
<td>Pilot Benefit Costs</td>
<td>2.611%</td>
<td>$3,844.38</td>
</tr>
<tr>
<td>Property Tax</td>
<td>2.239%</td>
<td>$3,296.22</td>
</tr>
<tr>
<td>Pilot Per Diem Costs</td>
<td>1.897%</td>
<td>$2,793.62</td>
</tr>
<tr>
<td>Property Insurance Costs</td>
<td>1.599%</td>
<td>$2,355.07</td>
</tr>
<tr>
<td>Professional Pilot Training Costs</td>
<td>0.718%</td>
<td>$1,056.73</td>
</tr>
<tr>
<td>Services (de-icing, preheating, towing, etc.)</td>
<td>0.641%</td>
<td>$944.06</td>
</tr>
<tr>
<td>Hangar Fees</td>
<td>0.173%</td>
<td>$255.44</td>
</tr>
<tr>
<td>Ground Transportation Costs</td>
<td>0.142%</td>
<td>$208.95</td>
</tr>
<tr>
<td>Non-Professional Pilot Training Costs</td>
<td>0%</td>
<td>$0.00</td>
</tr>
</tbody>
</table>

**Total Cost:** $147,241.91

Figure 6-10 This plot shows the total cost of each expenditure item for each Monte Carlo simulation.
6.6 Pilot Data

6.6.1 Air Taxi Pilot Data

This section contains a single table which can be accessed by selecting Output->Pilot Crews/Revenue->Pilot Crew Statistics – per Crew Id from the menu bar on the main window. The table provides a breakdown of hours flown for each individual pilot crew in the simulation. An example is shown in Figure 6-11.

![Pilot Crew Statistics Table]

Figure 6-11 This table shows the number of pilots required to operate the air taxi service.
Appendix A – Air Taxi Cost Element Definitions

All variables that are described as “specified” are derived directly from user inputs into the MCATS program. Some inputs are entered directly as constants, and are immediately used in calculations (e.g., simulation duration). Many others are specified as statistical distributions (Gaussian or uniform) subject to user-defined upper and lower bounds (e.g., fuel cost per gallon value). Based on these bounds and distribution types, these parameters are randomly cast by the simulator prior to use in calculations. All other parameters are calculated during the simulation (e.g., distance traveled by aircraft).

Also, note that the user must select one of two different operational modes for the simulation, which include “Service Provider Profit Margin” and “Passenger Cost per Seat Mile”. For the first case, the user specifies what the profit margin must be, and simulation yields the corresponding passenger cost per seat mile based on the simulation results. For the second case, the user specifies a passenger cost per seat mile and the simulation yields a resulting profit margin. Revenue calculations are dependent on this choice.

1. Independent Cost Elements

Fuel

cost = CPG*\[\sum T(i)\*V(i)\*E(i)\]

CPG – specified fuel cost per gallon
T(i) – total flight hours traveled by aircraft i, including hold patterns
E(i) – specified number of gallons of fuel consumed per nautical mile for aircraft i
V(i) – specified cruise velocity of aircraft i

Services

cost = (specified service cost per aircraft per week)*(duration of MC simulation in weeks)*(total number of aircraft)

Aircraft Depreciation

cost = [(specified annual percentage of hull value)/100%]*(total hull value of aircraft fleet)*(duration of MC simulation in years)

Hangar Fees

cost = (specified cost per week per aircraft)*(duration of MC simulation in weeks)*(total number of aircraft)

Property Tax

cost = [(specified annual property tax percentage)/100%]*(total hull value of aircraft fleet)*(duration of MC simulation in years)
**Pilot Salaries**

\[\text{cost} = \sum \left[ \text{PPC}(i) \times \left\{ \text{PFW} \times \text{FH}(i) + \text{PNFW} \times \text{NFH}(i) \right\} \right] \]

PFW – specified flight wage per pilot per hour  
PNFW – specified non-flight wage while on duty per pilot per hour  
FH(i) – total number of flight hours for crew i  
NFH(i) – total number of non-flight hours while on duty for crew i  
PPC(i) – number of pilots per crew for crew i

Note that in the calculation of salary costs the total flight hours, FH, are subject to a minimum flight time per month (default 75 paid hours per month) for each scheduled pilot. This value is scaled based on the actual simulation time duration. *Reserve* pilots are only paid for hours flown.

**Pilot Benefits**

\[\text{cost} = \left\{ \left( \text{specified percentage of pilot salary} \right) / 100\% \right\} \times \left( \text{pilot salary costs} \right) \]

**Professional Pilot Training**

\[\text{cost} = \left\{ \left( \text{specified percentage of pilot salary} \right) / 100\% \right\} \times \left( \text{pilot salary costs} \right) \]

**Non-Professional Pilot Training**

\[\text{cost} = 0 \text{ (No nonprofessional pilots modeled for current air taxi simulation model)}\]

**Pilot Per Diem Costs**

\[\text{cost} = \text{HC} \times \sum \left[ \text{N}(i) \times \text{PPC}(i) \right] \]

HC – specified per diem costs per night per pilot  
N(i) – number of nights spent away from home airport while on duty for crew i.  
PPC(i) – number of pilots per crew for crew i

**Property Insurance**

A table is provided to the user which contains columns for the annual cost per aircraft (user provides both mean and standard deviation values), and rows for various hull values. The table is linearly interpolated for values of the mean and standard deviation if the specific aircraft’s hull value falls between the values set for two given rows.
The property insurance cost for the entire fleet is calculated as follows:

\[ \text{cost} = T \sum \left[ \text{IPIC}(HV(i)) \right] \]

- **T** – duration of MC simulation in years
- **HV(i)** – hull value of aircraft i
- **IPIC()** – interpolated annual premium for property insurance per aircraft as a function of the aircraft’s hull value

**Liability Insurance**

\[ \text{cost} = \left( \frac{(\text{Amount of Liability Insurance Coverage per Passenger Seat}) \times (\text{Total passenger seats in fleet}) \times (\text{Amount per Passenger Seat per $1M Coverage per year}) \times (\text{duration of MC simulation in years})}{1,000,000.0} \right) \]

**Cost of Borrowing**

\[ \text{cost} = \left( \frac{\text{specified annual percentage}}{100\%} \right) \times \left[ 0.90 \times (\text{total hull value of aircraft fleet}) \right] \times (\text{duration of MC simulation in years}) \]

**Non-Aircraft Costs**

\[ \text{cost} = \left( \frac{\text{specified percentage}}{100\%} \right) \times (\text{total hull value of aircraft fleet}) \times (\text{duration of MC simulation in years}) \]

**Aircraft Maintenance Costs**

A table is provided for users to enter the mean maintenance costs (dollars per hour) for each aircraft type in the simulation. Users also supply a standard deviation value to apply mean maintenance cost values. Scheduled and unscheduled costs are reported separately under the main heading and are added to give the overall maintenance cost figure.

\[ \text{cost} = \text{Scheduled Maintenance Costs} + \text{Unscheduled Maintenance Costs} \]

**Scheduled Maintenance Costs**

\[ \text{cost} = \sum \left[ SMC(i) \times T(i) \right] \]

- **SMC(i)** – specified scheduled maintenance costs per hour for aircraft i
- **T(i)** – total hours traveled for aircraft i
Unscheduled Maintenance Costs

\[ \text{cost} = \sum UMC(i) \times T(i) \]

UMC(i) – specified unscheduled maintenance costs per hour for aircraft i
T(i) – total hours aircraft i is out of service for unscheduled maintenance repairs

Ground Transportation Costs

\[ \text{cost} = GTC \times \sum NNM(i) \]

GTC – specified ground transportation costs per nmile.
NNM(i) – for all diverted flights taken by aircraft i which caused the aircraft to land at an alternate airport, this number represents the cumulative number of nominal distance nmiles between each intended destination – alternate destination pair for aircraft i.

Administrative and Scheduling Costs

\[ \text{cost} = \left( \frac{\text{specified percentage of operating costs}}{100\%} \right) \times \text{OPERATING_COSTS} \]

OPERATING_COSTS =
(fuel costs) + (services costs) + (hangar fees) + (pilot salary costs) + (pilot benefits) + (professional pilot training costs) + (nonprofessional pilot training costs) + (property insurance) + (liability insurance) + (aircraft maintenance costs)
2. Interrelated Cost Elements

Common Parameters

EXPENDITURES1 =
(fuel costs) + (property insurance) + (aircraft maintenance costs) + (services costs) +
(aircraft depreciation) + (hangar fees) + (property tax) + (pilot salary costs) + (pilot
benefits) + (professional pilot training costs) + (nonprofessional pilot training costs) +
(liability insurance costs) + (cost of borrowing) + (non-aircraft costs) + (administrative
and scheduling costs) + (pilot per diem costs) + (ground transportation costs)

α - [(specified income tax percentage)/100%]
β - [(specified profit margin percentage value)/100%]
γ - [(specified percentage of revenue for promotions and advertising)/100%]
δ – [specified passenger cost per seat mile]

Revenue

If operational mode = “Service Provider Profit Margin”, then

value = EXPENDITURES1*{(1 - α) + β}/[[1-(1-α)*(1-γ)] - β*γ}

Else if operational mode = “Passenger Cost per Seat Mile”, then

value = δ*( sum of all completed trip, including diverted flights, nominal
distances traveled by all passengers in MC simulation)

Promotions and Advertising Costs

cost = γ*(revenue)

Income Tax

If (profits before taxes) > 0

cost = α*(profits before tax)

Else

cost = 0

Expenditures

cost = EXPENDITURES1 + (promotions and advertising costs)
Profits (before taxes)

value = (revenue) – (expenditures)

Profits (after taxes)

If (profit before tax) > 0

value = (profit before taxes)*[1 - \(\alpha\)]

Else

value = (profit before tax)

Resultant Mode Value

If operational mode = “Service Provider Profit Margin”, then

Pass Cost per seat Mile = (revenue)/(sum of all completed trip, including diverted flights, nominal distances traveled by all passengers in MC simulation)

Else if operational mode = “Passenger Cost per Seat Mile”, then

Profit Margin = 100%*(profit after taxes)/(expenditures)
Appendix B – Air Taxi Input/Output Summary

Inputs

Simulator Options
- Operation Mode:
  - Specify Profit Margin or Cost/Seat-Mile
- Duration of Simulation
- Start Date for simulation Run
- Number of Monte Carlo Cycles
- Initial Random Number Seed Value
- Deadheading Logic Selection (On/Off)

Airport Options
- Select Airports for Evaluation
- Add/Delete/Edit Airports
  - Specify Population Statistics
  - Specify Latitude/Longitude Position
  - Specify Time Zone
  - Associate METAR Weather Data-Sets
  - Specify specific takeoff/landing minima
- Blanket Takeoff or Landing minima overrides

Aircraft Options
+ Aircraft Properties
  - Select random maintenance failures on/off and duration out of service
  - Replace/Edit Aircraft
    o Initial Cost
    o Number Of Seats
    o Number Of Pilots Required
    o Cruise Velocity
    o Fuel Capacity
    o Fuel Efficiency
    o Range
    o Pressurized (yes/no)
    o Maintenance Failure Likelihood

+ Aircraft Fleet
  - Number of Aircraft (by type) in Fleet
  - Type Quantities in Fleet

+ Airport Distributions
  - Initial Aircraft Quantities at Airports
  - Override Busy Times after Landing
  - Nightly Return to Home Airport Option

Passenger Statistics (Normal, Uniform, or Constant)
+ Passenger Volumes
  - Passenger loading probabilities by hour
  - Number of Daily New Passenger Trips
  - Accommodation (Dispatch) Intervals
  - Advanced Reservation Time
  - Quantity of Advanced Reservations
  - Intervals to Requeue Stranded Pax

+ Origin/Destination Statistics
  - Maximum Trip Duration (Passenger Comfort Interval)

- Minimum/Maximum Service Area
- Origin/Destination Pair Probabilities

Costing (Normal, Uniform, or Constant)
+ Operational Costs
  - Administration/Scheduling Costs
  - Fuel Costs (JetA and 100LL)
  - Services
  - Aircraft Depreciation
  - Hangar Fees
  - Promotions/Advertising
  - Ground Transportation
  - Property Tax
  - Income Tax

+ Pilot Related Costs
  - Commercial Flying Wage (pilot & co-pilot)
  - Pilot Benefits
  - On Duty Non-Flying Wage
  - Per Diem Costs
  - Minimum Flight Hours Paid per Month
  - Professional Pilot Training Cost
  - Non-Professional Pilot Training Costs

+ Insurance
  - Property Insurance per Aircraft (based on hull value) for $200k Increments for Professional & Non-Professional Pilots
  - Desired Amount of Liability Insurance per Passenger Seat
  - Costs for Liability Coverage per Passenger Seat per $1M

+ Inventory Costs
  - Uniform Hull Value Increase
  - Non-Aircraft Costs
  - Cost of Borrowing
  - Hourly Scheduled & Unscheduled Aircraft Maintenance Costs (by aircraft type)

Weather Parameters
- Enable/Disable All Weather
  o Enable/Disable only METAR Data
  o Enable/Disable only RCM Data
- Max Delay Before Canceling Flight
- Condition Recheck Interval
- Max Holding Time
- Forecast Robustness (for good/bad conditions)
- Maximum Weather Impeded Trip Distance
- Minimum Cell Avoidance (for pressurized aircraft and for non-pressurized aircraft)
- Cell Avoidance Type (by color code/intensity)
Outputs

Resulting Profit Margin OR Cost per seat-mile

Airport Statistics
- Requested/Denied Passenger Trips
- Aircraft Departures/Arrivals
- Percentage of Denied Passengers
- Average Passengers per Trip
- Originating/Arriving Deadheads
- Percent Originating/Arriving Deadheads
-Originating Diverted Trips
- Delayed Flights
- Cancelled Flights
- Total Requested/Denied Passenger Trips
- Total Aircraft Trips
- Passenger Trips Requeued
- Successful Requeue Attempts

Aircraft Statistics
- Total Distance Traveled
- Total Time Traveled
- Total Time Idle
- Total Idle Percentage
- Airborne Passengers per trip (Avg. for full simulation only)
- Airborne Deadhead % (avg. for full simulation only)
- Total Aircraft Flights
- Load Factors

Expenditures/Revenues
- Cash Flow – Average Weekly Profit for Entire Simulation.
- Cost Element Statistics (by cost input type or total)
  - Absolute costs OR cost per operating hour per aircraft
- Cost Element Distribution: Percentages & Costs of Each Category.

Pilot Crew Statistics
- Crew Type
- Service type
- Number of Pilots in Crew
- Assigned Aircraft Id
- Assigned Aircraft Home City
- Total Flight Hours
- Total Passenger Carrying Hours
- Number of Hotel Charges
- Total Scheduled Crews
- Total Reserve Crews

Passenger Statistics
- Total Nominal (Revenue) Distance Traveled
- Total Time Traveled
- Percentage of Passenger Trips Denied based on Individual Simulation Number
  - Average for Entire Simulation, including Weather
  - Average for Entire Simulation, excluding Weather
- Percentage of Passenger Trips Denied per airport
  - Weighted average for entire simulation, including Weather
  - Weighted average for entire simulation, excluding Weather
- Average Same-Day Trips
- Passenger Trip Times
- Passenger Trip Distances